
Real 3D programs have several advantages over After
Effects: For example, their objects have real depth, and

the texturing and lighting options are far more advanced.
However, this power often comes with a significant speed
penalty, which can be a problem when accommodating client
changes. After Effects is also the better tool in which to refine
the final look of your 3D worlds. Offloading portions of the
work from your 3D program to After Effects will save time
while giving you more power and flexibility – but it requires
some planning to set up. 
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Techniques to get 
more information 
from your 3D program
into After Effects.

Example Project
Explore the 40-Example
Project.aep file as you read this
chapter; references to [Ex.##]
refer to specific compositions
within the project file. 

Integrating with 3D Applications
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3D Channel Effects
Bonus Chapter 40B on this
book’s DVD covers the special
3D Channel effects such as
Depth of Field and Fog 3D, 
as well as how to replicate 
their results with 3D programs
not directly supported by 
these plug-ins.

FA C T O I D

In this chapter, we will give advice on how to successfully integrate
your 3D program with After Effects. We will then work through a pair of
case studies: Adding 2D video to the face of a 3D object, and integrating
lights and shadows between After Effects and your 3D render. The DVD
also contains a bonus chapter which covers the 3D Effects that can
access additional information saved with some 3D renders such as the Z
buffer (how far objects are away from the camera).

Unfortunately, there is no one universal file format to bring informa-
tion from a 3D application into After Effects. In our case studies, we are
going to focus on using Maxon Cinema 4D as it currently has the tight-
est integration with After Effects, plus is the 3D program we personally
use. However, many of the concepts we’ll be covering are universal and
can be applied to other programs as well. We will also include some
 specific advice for programs such as Autodesk Maya and 3ds Max.

Tight integration makes it easier to add video and other layers to 3D environments
in After Effects. Video courtesy Creative License; textures courtesy Artbeats.

Excerpt from Creating Motion Graphics with After Effects, 5th Edition for CS5.
Copyright © 2010 Trish and Chris Meyer.

Published by Focal Press, ISBN: 978-0-240-81415-5

No part of this publication may be reproduced or distributed in any form or by any means.



3D Advice
The next few sections include topics to keep in mind as you work on a
project that will flow from a 3D program to After Effects. This includes
getting the camera move across, lining up world coordinates between
the two programs, and creating mattes so that select objects in the 3D
world will appear to pass in front of layers added in After Effects.

The Camera Move
A typical workflow will include finalizing your camera move in the 3D
program, rendering the 3D scene, then bringing the camera move and
render into After Effects. Your render will be a 2D layer in After Effects,
as it already has the camera move calculated into it; you can optionally
enhance the render using After Effects’ tools. You can then add new 3D
layers on top of this render in After Effects, using the camera data you
moved across. For example, you can add text, video, and other objects to
your scene in After Effects without having to go back into your 3D pro-
gram for another potentially lengthy rerender. 

It is a really, really good idea to finalize the camera move before bring-
ing it into After Effects. Changing the camera move means having to re -
render the 3D scene as well as replace the camera move in After Effects.
Do a few rough renders and get the client to sign off on the general idea
and movement before putting in too much work.

The way you move camera data from
a 3D application into After Effects varies
from program to program. Here are
some of the more common options:

� Export your project to the .ma – Maya
ASCII – format. After Effects can then
import this project through its normal
File > Import menu command; it will
extract the camera movement from this
file along with the movement of any null
objects that explicitly have the word
“NULL” or “null” in their name. An
example of the result is demonstrated in
this chapter’s example project in the
comp [Ex.01-Maya Import]. If your pro-
ject uses non-square pixels, a square
pixel precomp will also be created which
contains the actual camera animation.

� Embed the camera move in a .rla or
.rpf frame sequence when you render.
Bring this sequence into an After Effects
comp, select it, and use Animation >
Keyframe Assistant > RPF Camera Import.
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Maya Camera Import Bug
There is a known issue where
some older Maya .ma projects
may import at the wrong size.
For example, Maya_camera.ma
included on this book’s disc
imports as 540x486 pixels, 
when it should be 320x240.

G O T C H A
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Programs such as 3ds Max can embed their camera move in an RPF file
sequence during their render. After Effects can extract this data to create 
a matching camera of its own.

Maya ASCII (.ma) project files may be imported directly into After Effects. 
The result is a comp with the Maya camera, any null object with “null” in its
name, parenting chains including cameras and nulls, and their animation.

Motion Blur
If you rendered your 3D scene
with motion blur enabled, you
should also enable motion blur
for the 3D layers you add in
After Effects. Don’t forget to
match the blur’s shutter angle
you used in your 3D program.

T I P
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Camera Data Translation
Several users and third parties have created plug-
ins and scripts to help move camera data and
related information between After Effects and
select 3D programs that may not have broad
After Effects support built in:

� MAX2AE from Boomer Labs 
(www.boomerlabs.com) allows you to import a
scene from After Effects into 3ds Max 6 or later.
It also provides a nice alternative to importing
Max scenes into After Effects, including support
for lights and “helper planes.” 

� 3DMation’s MoCon (www.3dmation.com) is a
collection of scripts to transfer 3D motion to and
from After Effects, Maya, Nuke, SynthEyes and
Electric Image, including going from After Effects
into Modo.

� Several useful scripts reside on the essential 
AE Enhancers site (www.aenhancers.com), includ-
ing getting an After Effects camera move back
into Cinema 4D or 3ds Max, plus exporting a
simple representation of your scene from After
Effects to Maya, Max, and LightWave.

� Byron Nash has created a Softimage|XSI script
that exports cameras, lights, nulls, and polygons
from XSI to After Effects. It’s available at:
armoredsquirrel.com/blog/?page_id=69

Integrating with 3D Applications // 40

B

After Effects will then create its own camera with the
same movement. You can practice this with the comp
[Ex.02_starter]; the result – along with some addi-
tional compositing tricks using 3D Effects – is
demonstrated in [Ex.02-final].

� Cinema 4D has the ability to save an .aec project
file which contains the camera move and much,
much more (which we will discuss in detail in the
upcoming case studies). After Effects can then import
the .aec file with a Maxon-supplied plug-in. 

� If the functionality you need isn’t built into your 3d
program of choice, you may be able to write a spread-
sheet or script that converts keyframe data from your
3D program into After Effects keyframe data, and
paste that into a new camera created in After Effects;
see the Camera Data Translation side bar for leads on
others who have already.

� Worst case, create an object in your 3D world in the
same location as layers you would like to add in After
Effects, with obvious markers in its corners. Make a
separate render pass of this object, and use Motion
Tracking in After Effects to corner pin your new layer
into the position and perspective you had in mind.
This was demonstrated in Chapter 30’s [Ex.05];
another example is included in this chapter’s [Ex.03].

Sometimes, your imported camera move will not
appear to match the motion in your 3D render. The
most common problem is that the Angle of View for
the After Effects camera is wrong. Verify the value for
this parameter (also known as Field of View) in your
3D program, and enter this value manually in the
Camera Settings dia-
log in After Effects. 

Some 3D programs
also do not take into
account any curves
you may have applied
to the camera’s path
or speed. Therefore,
you will often need to
“bake” the camera
move in the 3D pro-
gram to create a key -
frame for every frame of your timeline before
exporting its move. For example, in Maya use Edit >
Keys > Bake Simulation in Maya.

A

If there is no way to import the camera data
from your 3D program into After Effects,
you can create a 3D model with dots to
track in After Effects (A), and corner pin a
new layer in After Effects to their location
(B). 3D renders courtesy Reject Barn.



When Worlds Align
When you try to place a new object in After Effects into your already-
rendered 3D world, the next question becomes: How big should every-
thing be? It can be quite disconcerting to, say, add a video capture to a
scene only to find it is several times bigger than everything in the 3D ren-
der – or at the other extreme, is just a few-pixel speck to the 3D camera.

In an ideal world, you should first decide on the sizes of the objects
you will be adding in After Effects – such as 1080-line tall HD video, or a
72-pixel tall text caption – and construct your 3D world so that its mod-
els have a good size relationship to these layers. 

For example, if we know we will be compositing standard definition
video onto 3D video walls we’re about to construct, the first thing we’ll do
in our 3D program is create a plane that is the same number of “world
units” as our video is in pixels, and then build the rest of our world based
on that reference. If you were not fortunate enough to plan this out
ahead of time, or run into common issues such as the world units are in
meters but the camera position translation is in centimeters, just

increase or decrease the Scale value
of the new layers in After Effects to
resolve the difference.

In addition to the size of objects,
you also need to know where they
are located! If you’re lucky, your 3D
program of choice translates the
position of objects other than just
the camera. For example, importing
a Maya .ma file will also bring across
any null objects with NULL in their
name. Place a null object where the
face of your videowall or line of text
should be, and you can use the
resulting coordinates to copy and
paste to your new object in After
Effects. In Cinema 4D, you can add
an External Compositing tag to an
object, which will cause a null object
or solid to be created at the same
place in After Effects. Dummy lights
or cameras are also sometimes used
in other programs for this purpose. 

Worst case, you can write down
those coordinates and manually
type them in. Just be aware of where
the anchor point of your 3D object
is: Quite often, it may be in the mid-
dle of the model, rather than on its

660

40 // Integrating with 3D Applications

When building a video screen in a 3D program, we start by creating a dummy
plane (the green rectangle) that corresponds to a square pixel size for the video
we later plan to place on it. We then make our video screen (the gray boxes)
slightly smaller so we can later crop off the Action Safe area of the video.

The 50 Percent Solution
If we know we will be
compositing a layer in After
Effects onto the surface of a
3D model, we usually try to
make that surface average
50% luminance (gray) after 
it has been textured and lit. 
If we composite the new layer
in After Effects using modes
such as Overlay or Hard Light,
it will pick up the lighting and
shadows that fall across the
3D surface without unduly
changing the appearance 
of the new layer.

T I P



face. Make sure the anchor is in the same relative
position between the two programs, such as the
bottom of the 3D object and the After Effects layer.

On occasion, you may find that some of the axis
units are reversed between your 3D program and
After Effects. For example, After Effects considers
a positive Z Rotation to be clockwise; some pro-
grams think a positive Z Rotation means counter-
clockwise. It is easy to change the sign of a value
for an object’s location; it is a little trickier when
this translation is already factored into, say, the
camera’s keyframes. Fortunately, you can use fairly
simple expressions to perform the reverse trans-
lation. In our hypothetical example, you would
merely assign the expression –value to Z Rotation;
the resulting expression for Position would be
[value[0], value[1], –value[2]].; modify as needed for
other dimensions. 

And remember, you might also need to throw in
an additional multiplier for world unit translation
issues, such as *10 or /10 for the difference between
meters and centimeters.
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Place your object’s anchor point at the location where you plan 
to place the corresponding layer in After Effects – such as on the
face (not in the middle) of a videowall (above). Then either write
down its coordinates, or find a way to export its position such as
using an External Compositing tag in Cinema 4D (below).



Mattes
Your 3D renders will be used as 2D layers in After Effects. You then need
to place any 3D layers you add in After Effects on top of these renders.
But what if you want the illusion that an object in your 3D render is pass-
ing in front rather than behind one of your new layers? Or on a simpler
level, what if you want to isolate one object in your original 3D world
for color correction or other treatment inside After Effects? 

The solution to both of these is to render a separate movie based on
the object you wish to isolate, and to use it as a track matte to cut out a
portion of either your new layer or a copy of your original 3D render.
Exactly how to go about this again varies from program to program. Here
are some typical approaches:

� In 3ds Max, assign an Object ID to the model piece you wish to isolate
(done in the Object Properties dialog by changing the G-Buffer Object
Channel). If you have more than one model piece that should be part of
the same matte – such as the faces of a series of letters – it may be easi-
er to texture them with the same material, then use a Material Effect ID
(done in the Materials Editor). When you render, save this data in an
RPF Sequence as an Optional Channel. In After Effects, make a duplicate
of your render, apply Effect > 3D Channel > ID Matte, and select your
channel type and ID. The alpha channel of the result can then be used
as a matte. This is covered in more detail in Bonus Chapter 40B on the
DVD and demonstrated in layer 1 in this chapter’s comp [Ex.02-final].

� In Cinema 4D, select the object you need to create a matte for
in the Object Manager and add a Compositing tag to it (Tags >
Cinema 4D Tags > Compositing in Release 11’s Objects panel).
Then in the Add to Object Buffer section, enable one of the
Buffers and assign it a number. Finally, include this channel in
a Multi-Pass render. The result is a render that can be used as a
luminance matte. We will demonstrate this procedure in more
detail in the case studies later in this chapter.

� If your 3D program does not have an explicit way to create a
channel or render pass based on the object you wish to isolate, you will
need to manually set up a special render that isolates it. The most com-
mon approach is to assign a 100% self-luminant white texture or mate-
rial to the object in question, then assign pure black materials to all the
other objects (make sure that this material does not react to any lights –
set reflections, specular highlights, and diffuse values all to 0%). Render,
and the result will be a luma matte for that object. There are also
approaches that create alpha mattes: In Maya, you can apply Use
Background to objects that are supposed to be transparent; in other pro-
grams such as Softimage|XSI you can alter the alpha value of an object
(used in [Ex.03-final]).

We will demonstrate how to use these mattes in the case studies as
well as in Bonus Chapter 40B.
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In Cinema 4D, you can apply a
Compositing tag to a layer, and
designate it to create a high-contrast
matte in an “object buffer.”

In programs that support the RLA or RPF
format, assign a Material or Object ID to
the surface you want to use as a matte.
Then use the ID Matte effect (above) 
to isolate it in After Effects, allowing it 
to be used as an alpha matte (below).
3D render courtesy Fogline.

Reflections and Mattes
If you can see the reflection 
or refraction of one object in
another, there is a chance this
artifact will be included in a
matte or object buffer created
by the 3D program.

G O T C H A



Study #2: Shadow Trickery
One of the more challenging areas of integrating a 3D render with After
Effects objects is handling the shadows. You’d like for any new objects
you add in After Effects to cast 3D shadows onto objects in the original
3D render. However, the 3D render must be imported as a 2D layer, and
3D layers cannot cast 3D shadows onto 2D layers. Your choices? Do with-
out, fake it with an ordinary 2D Drop Shadow effect, or do a little extra
work: Add 3D layers in After Effects to mimic objects in the original 3D
scene which can then catch the 3D shadows. Let’s try this last approach.

Open [Ex.06_starter]; it contains a more complex room with a win-
dow in the back wall to worry about as well as a table. Here are the steps

needed to make it shadow-friendly in After Effects:

Step 1: The wall, floor, and table are candidates to
catch shadows, so we need to know where to place
their stand-ins in After Effects. We made a note of
their sizes and where their faces were located in 3D
space. In Cinema, we set their anchors to the center
of their faces, then applied External Compositing
tags (discussed in the previous section) to these
models. This resulted in null objects being created
for them in the corresponding .aec file.

Step 2: To crop our stand-in layers, we needed to
render mattes that corresponded to just the visible
portions of the faces of these models. In Cinema, we
applied Compositing tags to these objects and
assigned them to individual Object Buffers. We did
the same for the Harlequin title so we could place
layers in After Effects “between” the title and the wall.

Step 3: Once these 3D passes were rendered, we imported them along
with the camera and light data into After Effects. We’ve already done this
for you in [Ex.06_starter].

Open the composition that was created and note the three null
objects back wall, floor, and tabletop. You need to replace these with
solids. Here are the steps for one; the others are done the same way:

Step 4: The face of the back wall model piece is roughly 3110 wide ¥
1050 high in “world units” in Cinema, so create a Layer > New > Solid of
this size, using square pixels and colored white. Name it “wall shadow”
and click OK.

Step 5: Next, you need to move this shadow catcher into the same
position as the wall. To do this, enable the 3D Layer switch for wall shad-
ow. Select back wall (the null object created by Cinema) and type P fol-
lowed by Shift+R to reveal its Position and Rotation parameters. Copy
these, and paste them to wall shadow.
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Follow Along
For those with Cinema 4D, our
original Cinema project file for
Study #2 is on this book’s disc in
40_Chapter Sources > Cinema
4D Projects > C4D Room.

T I P

More on Multipass
Check out dvGarage’s Multi-Pass
Render Lab for a set of in-depth
training materials on enhancing
renders using a multipass
approach (visit dvgarage.com
and look under Products > 
3D Development).

T I P

Steps 1–2: We added Compositing 
and External Compositing tags to the
tabletop, floor, and back wall models
to generate null objects and mattes for
them in After Effects. We also added 
a Compositing tag to generate a 
matte for the Harlequin title model.



Step 6: We want this layer to receive our new shad-
ows, but not otherwise be affected by lights in this
scene. With wall shadow still selected, type AA to
reveal its Material Options in the Timeline. Leave
Casts Shadows = Off and Accepts Shadows = On (their
defaults), but set Accepts Lights to Off.

Step 7: The shadow catcher needs to be matted to
match the visible portions of the 3D wall. In the
Special Passes folder, locate AEA Room_object _2.mov
and drag it into your comp just above wall shadow.
Reveal the Modes column (F4) and set the TrkMat
popup for wall shadow to Luma Matte.

Step 8: To composite just the dark shadows – not
the wall’s white color – onto the back wall, set the
Mode popup for wall shadow to Multiply.

Step 9: Add a layer to the scene in After Effects, enable its 3D switch,
and enable Cast Shadows. Its shadow will appear on the back wall of the
original 3D render. Feel free to tweak the color, intensity, and shadow
darkness of the lights originally created in Cinema to work best for your
new layers in After Effects, but keep their positions if you want the new
shadows to match the original render.

If you want to cast shadows on the floor or table, repeat steps 4–9
above and use these parameters:

� The floor is about 3100¥2050 pixels in size and uses Object Buffer 3.
You will need to set its X Orientation to 270° to flip it down horizontally.

� The tabletop is approximately 512¥512 pixels and uses Object Buffer
4. Due to differences in how the object was created in Cinema, disable
keyframing for the three Rotation values, zero out Y Rotation and instead
set Z Rotation to –17°, and set X Orientation to 270° to flip it down.

The comp [Ex.06-Shadow Trickery-composite] has these three shad-
ow catcher layers set up, with some new objects casting shadows. Adding
3D elements from After Effects into a fully rendered 3D world creates an
interesting hybrid look in its own right; you can also gain substantial
flexibility from distributing your workflow between the programs.

671

Integrating with 3D Applications // 40

Blending modes: Chapter 9.

Track mattes: Chapter 11.

Working in 3D: Chapters 13–16.

Null objects and parenting: Chapter 17.

Time stretching: Chapter 28.

Corner pin motion tracking: Chapter 30.

Expressions: Chapter 37.

Importing files and the Interpret Footage 
dialog: Chapter 38.

Pixel aspect ratios and frame rates: Chapter 41.

C O N N E C T

A

Steps 4–8: Create a white solid the size of the back wall, put it in the same position (A), set its Material Options > Accepts Lights
to Off (B), crop it by its corresponding matte (C), and set its Mode to Multiply (D) so it blends into the original 3D render.

B C D

After you’re done, new 3D layers added
in After Effects can cast shadows on the
wall, floor, and table. If you have Cinema
and are up for a challenge, use our
projects to also create a shadow catcher
for the Harlequin title…
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